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Copyright notice

No part of this Instructions for Use or program may be reproduced, stored in a retrieval system,
or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or
otherwise, without the prior written consent of Auditdata A/S.

Copyright © 2024, Auditdata A/S
Written in Denmark by Auditdata A/S, Denmark.

All information, illustrations, and specifications in this manual are based on the latest product
information available at the time of publication.

Auditdata A/S reserves the right to make changes at any time without notice.
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1 Introduction

This document aims to provide instructions on setting up Fitting and HIT Units as well as
installing and configuring the Primus software. It also includes essential information on safety
measures, maintenance, and calibration.

The Fitting Unit is a general term combining PFU, PFU+, Primus Pro, Primus Ice, and 2000-1
FU hardware units. Please refer to the Abbreviations and Terms section for definitions of these
units.

Up to version 4.2, the software was released under the name of Primus. The release following
Primus 4.2 aquires the name Measure and the version number 6.0.

Depending on your purchased licenses, some of the modules described in this document might
not be available in your version of software. Please contact your distributor to get more
information on the licenses.

This document is not intended to be a complete reference. For detailed information, please
refer to the Help file after installing the software.

2 Abbreviations and Terms

Term Definition

PFU stands for Primus Fitting Unit. This includes PFU, PFU+, and Primus

PFU Pro hardware units. These units are used to perform pure tone and speech meas-
urements as well as REM and SM measurements.

Fitting - . . - . .

Unit Fitting Unit is the collective name for all fitting unit devices.

Primus Primus Ice is the name for Primus Audiometer Unit. This unit is used to perform

Ice pure tone and speech measurements only.

HIT HIT stands for Hearing Instrument Test chamber.

AUD Audiometry.

REM Real Ear Measurements.

SM Speech Mapping.

Hearing Threshold Level. Establishes the minimum level at which the client can

HTL . o
detect the presence of a pure tone signal 50% of the time it is presented.
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Model name | Product | Additional information
2000 Primus Primus
Fitting Unit
Pro
Pro
2000 Primus Primus
Audiometer lce PFU (Primus Fitting Unit) is the collective name for these devices:
Unit Ice Primus Pro, Primus lIce and Primus PFU+.
PRIMUS
FITTING Primus
UNIT+ PFU+
(PFU+)
2000 Primus
HIT Pro Primus
(2005-1 HIT | HIT Pro
Unit)
2000-1 FU stands for Type 2000-1 Fitting Unit. This Unit is in
functionality very similar to the PFU and is also used to perform
2000-1 pure tone and speech measurements as well as REM and SM
2000-1FU | Fitting measurements.
Unit
In Measure software, the device is displayed as 2000-1 Fitting
Unit (Measure Aud).
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3 Symbols Used

The following symbols are used in this document and/or on labelling on the device.

Labels on Fitting Unit and HIT Unit

N

H\Iizi E L

X
(1]
=

=S
O

Labels only on Fitting Unit

> E O O] >

‘)

€ 0123

Labels only on HIT Unit

>

Manufacturing date

Manufacturer's name and address

Disposal instructions

Serial Number
Reference Number

This device is a medical device

Type B applied parts.
Patient applied parts that are not conductive and can be
immediately released from the patient.

Class Il equipment

Follow operating instructions

Operating instructions

General warnings

CE - notified body

Caution, please read the Instructions for Use and the User
Manual
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Ce .

4 Compliance with Standards

Classification according Annex VIl of EU Medical Device Regulation MDR (EU) 2017/745:

Device Class Rule CE GMDN Basic UDI-DI

Primus Fitting Unit (all vari- | 10 | |45241 |05711781DHF20002C

ants) 0123

Primus Audiometry Unit (Ice) | Ila 10 |°F {37503 |05711781DHF2000ZC
0123

Primus HIT Pro | 13 |CE | 41217 |05711781DHF2000ZC

2000-1 FU (2000-1 Fitting | |, 10 |CF  |45241 |05711781DHF2000ZC

Unit) 0123

Note: Medical device classification may vary across different markets depending on local
legislation.

All Auditdata devices covered in this manual, including the listed accessories and respective
applied parts, comply with the Council Directive RoHS-1I/2011/65/EU.

The Fitting System complies with the following standards:
Safety:

e |[EC 60601-1:2005+A1:2012 CSV, class 2, type B
e |[EC61010-1:2010 for HIT Unit

EMC:
e |[EC60601-1-2:2014+A1:2020 CSV
Audiometry:

e Tone: IEC 60645-1:2017 / ANSI S3.6:2018 Type 1
» Speech: IEC 60645-1:2017 / ANSI S3.6:2018 Type A or A-E

Real Ear Measurement:
e |[EC 61669:2015 and part of ANSI $3.46:2013
Hearing Instrument Testing:

e |[EC60118-7:2005
e |[EC60118-15:2012
e ANSI S3.22:2009
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Medical electrical equipment

e EN 60601-1-6:2010+A1:2013+A2:2020
Medical device software

e |[EC 62304:2006+A1:2015
Medical devices

e |[EC62366-1:2015

e ENISO 14971:2019

e« ENISO 13485:2016
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5 Intended Use/Indications for Use

The Fitting Unit is intended for use by professionals such as an audiologist, hearing healthcare
specialist, or trained clinicians. The devices must only be used for their intended purpose as
stated in this document below.

Audiometric testing should take place in a sound treated quiet environment and care should be
taken to ensure optimal test conditions and safety of the client during testing.

2000-1 Fitting Unit , PFU and Primus Ice

The Fitting Unit is intended for performing hearing tests.

The Fitting Unit with stated accessories is indicated for non-continuous, noninvasive air
and optionally bone conduction and speech audiometric testing in quiet office and sound
treated environments.

The Fitting Unit is indicated for use with both paediatric and adult age groups.

The Fitting Unit is not indicated as a sole means of diagnostics.

2000-1 Fitting Unit and PFU Only

e The Fitting Unit is indicated for non-continuous real-ear measurements at the ear drum by
means of noninvasive external ear canal insertion of a probe tube in quiet office
environments.

¢ Finally, the Fitting Unit can be used to present hearing instrument related sound
examples through headsets or loudspeakers.

2005-1 HIT Unit

¢ The Hearing Instrument Test Unit is intended for use by professionals such as an
audiologist, hearing healthcare specialist, or trained technician.

¢ The Hearing Instrument Test Unit is intendent to apply sound to the hearing aid in a
closed test box and obtain the acoustical output of the hearing aid in a coupler cavity
equipped with a microphone.

e The Hearing Instrument Test Unit is intended to be used together with the Software to
provide objective indication of the characteristics of a Hearing Aid. Visualization of the
obtained coupler microphone signal is only available in the Software application.

¢ The Hearing Instrument Test Unit is indicated for technical quality inspection or fitting of
hearing instruments with no clients involved.
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6 Safety Instructions

A\ PLEASE READ THE SAFETY INFORMATION COMPLETELY BEFORE USING THE FITTING
SYSTEM!

6.1 Applied parts

The headsets / patient switch are only to be used with uninjured skin of the test person.
The time of usage is short duration and less than 24 hours.

Parts that come into contact with the client (that is, transducers, the handheld push-
button, and the probe microphone set) should be disinfected before use.

6.2 Fitting Unit

Parts such as foam tips on insert earphones or probe tubes for real-ear measurement are
not intended for reuse. Dispose of such items in a hygienic manner after each client
session.

Do not use talk forward microphone in areas where there is risk of acoustical feedback.
The headphones supplied must not be used with any other branded equipment.
Headphones from other branded equipment must not be used with the system.

Connect only such headphones and other external devices that are approved for
connection to the System.

Probe tube measurements must be performed by trained professionals only.

Avoid exposing the client or other persons to unnecessarily high sound pressures, as
these may be damaging to hearing.

Before applying the headphones or insert phone, inspect the patient’s ear drum, ear
canal, pinna and surrounding areas for lesions or other types of infection. Do not use the
headphones or insert phones if any contraindications exist.

Remove any barriers before placing the headphones or insert phones on the patient,
such as jewellery or the patient’s hair during the test.

During real-ear measurements, carefully position the probe tube so as not to contact the
ear drum.

Accessory equipment connected to the analog and digital interfaces must be in
compliance with the respective nationally harmonized IEC standards ( IEC 60950 for data
processing equipment, IEC 60065 for video equipment, IEC 61010-1 for laboratory
equipment and IEC 60601-1 3rd for medical equipment). Furthermore all configurations
shall comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd.

Everybody who connects additional equipment to the signal inputs/outputs configures a
MEDICAL ELECTRICAL SYSTEM, and is therefore responsible that the system complies
with the requirements of the standard IEC 60601-1 3rd. If in doubt, consult the technical
service department or your local representative.

To comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd the Audiometer,
equipment parts and ACCESSORY, except for specified Type B applied parts, must be
located outside PATIENT ENVIRONMENT, i.e. not closer than approx. 1.5 meters/5 ft.

© Auditdata - 2024, 1D: 20.0109/22
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The use of accessory equipment not complying with the equivalent safety requirements of
this equipment may lead to a reduced level of safety of the resulting system.
Consideration relating to the choice shall include:

¢ Use of the accessory in the PATIENT VICINITY.

¢ Evidence that the safety certification of the ACCESSORY has been performed.

¢ |n accordance to the appropriate IEC 60601-1 3rd.

6.3 Fitting and HIT Units

6.3.1 Maintenance and Cleaning

Do not modify the equipment without authorization of the manufacturer.

Maintain a high level of hygiene and clean reusable devices which come into contact with
clients between each use. See the cleaning instructions below.

For cleaning use only a soft dry cloth dampened very sparingly with a low level
disinfectant solution such as isopropyl alcohol to wipe the device. Do not allow excess
solution to enter the device as this may damage internal components.

Do not use acetone or paraffin/kerosene-based solutions, or any other harsh solvent to
clean the device or its accessories. Use of such substances may be harmful to the
equipment and may result in faulty operation.

The headphones, probe microphone set, cables, connectors and other electrical
accessories are not waterproof. See the Cleaning instructions for safe handling.

6.3.2 Usage

The system with attached accessories is to be operated by qualified personnel only.
The device is intended only as an adjunct in client assessment. It must be used in
conjunction with assessment of clinical indicators and symptoms.

The main power supply should be easily accessible for plugging/unplugging.

"/ If the PC complies with IEC 60950 or with IEC 60601-1 3rd, use the USB cord to
connect to the system. Do not touch the USB connector from the PC and the patient at
the same time, when a IEC 60950 approved PC is used.

The device should be directly connected to the PC and not to a USB hub.

Do not use defective equipment. If you suspect a malfunction, contact a service
representative authorized by manufacturer for inspection of the equipment.

On a regular basis, that is, at least once a week, perform a visual inspection of the Fitting
and HIT Units and their accessories for visible damages. Do not use damaged
headphones or accessories with the device. During use, evaluate the test results and
perform a system inspection if the results appear unreliable.

When using the device with insert phones or probe-tube set, note that the used foam ear
tips or probe tube should be disposed in a manner consistent with normal infection
control procedures.
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In the event of irreparable damage to the device, dispose of it through an approved
hazardous materials disposal facility in accordance with the RoHS (Restriction of the Use
of Certain Hazardous Substances) and WEEE (Waste Electrical and Electronic Equipment)
regulations, or return it to manufacturer.
Do not connect non-medical equipment unless it forms part of the medical system. There
is a danger that the leakage currents may exceed their valid limits and consequently be a
hazard to the client and the examiner.
The devices should be contained in an environment according to the operational
specifications, so that the temperature and humidity does not rise above dangerous
measures. Refer to B.1 Technical Specification for allowed temperature, humidity, and air
pressure.
Do not expose the device to moisture. Extreme moisture can cause the device to fail or
perform inaccurately.
The devices must only be used for their intended purpose.
All tests must be conducted in a sound treated or sound proof room with low ambient
noise.
Excessive movements should be avoided during the test, as it may interfere with the
measurement and can result in wrong measurement results.
The headset and transducers delivered with the Fitting System and reference and coupler
microphones delivered with the HIT Unit are NOT intended for calibration by users.
Contact your local distributor for your annual service and calibration.
Do not pull the headphone cable. To disconnect the headphones or other accessories
from the device, pull the plug.
The examiner should take care never to touch non-medical parts of the system and the
client at the same time.
EXPLOSION HAZARD: Do not use the device in the presence of flammable substances.
ELECTRIC SHOCK HAZARD: Do not attempt to disassemble the device. The device
contains no user-serviceable items inside.
Carefully route all the cables to reduce the possibility of entanglement or strangulation.
Fasten the Fitting Unit on a wall, under a table or place it on a stable surface. If
considered more practical, the Fitting System can also be placed inside the audiometric
booth or piggyback to the HIT unit. Place the HIT Unit on a stable surface.
Do not place the system on or near equipment that generates a strong magnetic or
electrical field, as this may cause improper operation and interfere with the intended use
of the device.
If mobile multi-outlet power strips for mains power supply are in use:

e they must comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd

¢ their rated current must not be exceeded
Cables should be changed by properly qualified personnel only.
Any external equipment should be connected in such a way that the Fitting Unit with
connections still observes the safety requirements in IEC 60601-1 3rd.
Conductors and wiring between the system components must be protected against
mechanical damage.
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e [fthe PCis in use and not compliant with IEC 60950 or IEC 60601-1 3rd, use optical USB
connection Type OPTICIS M2-100-03 with power supply type Friwo FW7662M/05, type
Friwo FW8002M/05 or optical USB connection Type IF-TOOLS; ISOUSB-BOX-PLUS; Art.

No.: 14000.

¢ Use only with the power supply that is supplied with the system - type Friwo
FW7362M/15 or type Friwo FW8030M/15.

¢ Any serious incident that has occurred in relation to the device should be reported to the
manufacturer and the competent authority of the Member State in which the user and/or
patient is established.

6.4 HIT Unit

¢ The Hearing Instrument Test Unit is a laboratory equipment and must not come into
contact with the patient. The hearing instrument used in the HIT Unit must NOT be
connected to HIT Unit and the patient at the same time.

6.5 Contraindications

¢ Patients unable to cooperate because of young age or other conditions cannot undergo
pure tone or speech audiometry. They may need to have the auditory system tested by
other methods.

¢ The patient shall be asked about any exposure to loud noise during the previous 24
hours, as this can cause a temporary hearing loss. If the answer is yes then it may be
necessary to re-test the subject at a time when they have had no recent exposure to
noise.

¢ Audiometry shall be preceded by otoscopic examination. Occluding wax may be removed
prior to audiometry but if wax is removed the procedure shall only be undertaken by
someone who is qualified and competent to do so.
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7 Precautions

7.1 Principles of Operation
7.1.1 Audiometry

¢ Presentation of pure tone sine wave and speech stimuli for threshold determination and
supra-threshold testing within the range of 125 Hz to 16 kHz and varying intensity levels
to assess client hearing levels.

7.1.2 Real Ear Measurement

* Please also note the REM standard IEC 61669 mentioned in Chapter 4. Besides technical
specifications, terms and definitions, it contains additional helpful recommendations
regarding the test set up, such as location of subject and tester, or location of field
reference and measurement point.

Presentation of pure tone sine wave or complex stimuli within the range of 125 Hzto 16
kHz for measurement at the ear drum by means of a flexible probe tube inserted into the
ear canal. The measurement may take place with or without a hearing instrument
inserted.

7.1.3 Hearing Instrument Test System

¢ Presentation of pure tone sine wave or complex stimuli through a loudspeaker or teleloop
system within the range of 125 Hz to 16 kHz. Measurement and quality inspection of
hearing instruments in a dedicated hearing instrument test chamber.

7.2 Measurement Accuracy

If the accuracy of the device measurements does not seem reasonable, check the device for
proper functionality. The measurement and signal presentation data, including stability,
exactness and tolerances appear from the section Technical Specification.

Inaccurate measurements may be caused by factors such as:
¢ Excessive ambient noise in the test environment
¢ Excessive movements by client or operator

¢ Occlusion of the outer ear by hair or jewellery, or occlusion of the ear canal by objects or
cerumen

¢ Incorrect placement of headphones, probe microphone set or free-field loudspeakers
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¢ Incorrect headphones, loudspeakers or probe microphone set, or components such as
cables, ear cushions, etc.

* Malfunction of the headphones or the device

@ WARNING! Use of the device in any way other than as described in this document may
result in inaccurate results or injury.

7.3 EMC (Electromagnetic Compatibility) Precautions

The system is suitable for use in all establishments other than domestic, but it can be used in
domestic establishments and those directly connected to the public low-voltage power supply
network that supplies buildings used for domestic purposes, if the following warning is taken in
account:

@ WARNING! This system is intended for use in professional healthcare environment only and
might interfere or be disturbed by nearby equipment, therefore, it may be necessary to take
mitigation measures, such as reorienting, relocating or shielding the location.

Install and operate the System according to the EMC information, warnings and
recommendations to prevent adverse events to the patient and operator due to
electromagnetic disturbances for the expected service life time.

A\ WARNING! Failure to comply with the precautions listed in this section may cause
presenting of unwanted hearable noise or a wrong output on patients headset and therefore
the possibility of wrong client response.

@ WARNING! Do not place the system on or near equipment that generates a strong magnetic
or electrical field, as this may cause improper operation and interfere with the intended use of
the device.

RECOMMENDATION: To reduce the frequency of electrical shocks through ESD, the floors
should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the
relative humidity should be at least 30%.

RECOMMENDATION: The quality of the mains power should be that of a typical commercial or
hospital environment.

@ WARNING! Use of this equipment adjacent to or stacked with other equipment should be
avoided because it could result in improper operation. If such use is necessary, this equipment
and the other equipment should be observed to verify that they are operating normally.

@ WARNING! Use of accessories, transducers and cables other than those specified or
provided by the manufacturer of this equipment could result in increased electromagnetic
emissions or decreased electromagnetic immunity of this equipment and result in improper
operation.
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@ WARNING!: Portable RF communications equipment (including peripherals such as antenna
cables and external antennas) should be used no closer than 30 cm (12 inches) to any part of
the System including cables specified by the manufacturer. Otherwise, degradation of the
performance of this equipment could result.

For more information on the conformance of the system with the EMC standard EN 60601-1-2,
refer to Appendix B.

8 Installation and Set-Up

This installation procedure assumes that you will make a full installation. Skip irrelevant parts,
if you are not going to install all the modules.

Be sure to observe the safety requirements stated in this document, both during installation
and whilst using the Fitting system’s instrumentation and transducers. Do not connect external
devices unless they are suitable for connection to the Fitting System.

8.1 Hardware Setup

Note: No user-serviceable parts are found inside the Fitting Unit. Do not disassemble or modify
the unit!

8.1.1 Package and unpacking
External Inspection

Although your audiometer system parts were carefully tested, inspected and packed for
shipping, immediately examine the outside of the container after receiving the instrument for
any signs of damage. Notify your carrier if you observe any damage.

Unpacking

Carefully remove your audiometer system parts from its shipping container. If you observe any
mechanical damage, notify the carrier immediately so that a proper claim can be made. Be
certain to save all packing material so that the claim adjuster can inspect it as well. As soon as
the carrier has completed the inspection, notify your Auditdata representative.

If the instrument must be returned to the supplier, repack it carefully (in the original container,
if possible) and return it prepaid to the supplier for the necessary adjustment.

Package contents
Check carefully that you have got all system parts according to the delivery note.

If any system part is missing or the delivery is not according to your order, notify your Auditdata
representative immediately.
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8.1.2 Fitting Unit setup procedure

1. Unpack the Fitting System and cross-check that all ordered parts (as indicated on the

delivery note) are included. If any parts are missing, please contact your manufacturer for

support immediately.
2. Slot the appropriate connector to your power supply.

il
=
Ll
=g §

3. Fasten the Fitting Unit on a wall, under a table or place it on a stable surface. (If
considered more practical, the Fitting System can also be placed inside the audiometric
booth) or piggyback to the HIT unit.

Connect the USB cable to the inlet marked USB on the Fitting Unit.

Connect the other end of the USB plug into an empty slot on the operator PC.

Connect the power adapter to the DC inlet.

At the other end, connect the power plug to a power socket.

NOo oA

8. The plugs on the individual transducers come in specific colours, and should be plugged
into the connector marked with the same colour on the Fitting Unit. The name of the
connector is indicated next to the colour-marking on the Fitting Unit (see the table under
the picture).

2000 Primus Fitting Unit Pro, Primus PFU+

© Auditdata - 2024, 1D: 20.0109/22
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Table: Connectors for use in the Fitting Name on the Fitting Unit (and .
No Unit (plug/type in parenthesis) colour of transducer connectors if
plug/type In p highlighted)
DC power adapter (pin/hole) DC power
USB cable (USB type B, 2.0) USB
21 Sony/Philips Digital Interconnect S/PDIF*3
Format
3 Free Field Speaker, left (passive type) Left
(Anitek, H5-02-1-0-5-0)
Free Field Speaker, middle (passive
4 | type) Mid
(Anitek, H5-02-1-0-5-0)
5 Free Field Speaker, right (passive type) Right
(Anitek, H5-02-1-0-5-0) &
. L x1*2
Free Field Line Out (3.5 mm Stereo Mini | Left/Right - Rear - Sub/Mid
6-8 | Jack for connecting active speakers or Line Out 1 - Line Out 2 - Line Out
amplifiers) 3*3
. *1*x2
o Client/Demo Headset (3.5 mm Stereo | Client Headset
Mini Jack) Demo Headset*3
10 | Option (DIN 8 pin) Option “2*3
Operator microphone, left (3.5 mm .
11 Stereo Mini Jack) Left Operator Microphone
1 Operator.m.lcrophone, right (3.5 mm Connector not used
Stereo Mini Jack)
13 Ta.Ik_—back microphone(3.5 mm Stereo Talk Back Microphone
Mini Jack)
14 Operator hea(_js.et for monitoring (3.5 Monitor Headset
mm Stereo Mini Jack)
Air Conductor 1"
15 | Air conductor (DIN 8 pin) _*4
Air Conductor 3™
Air Conductor 174
16 | Alternative air conductor (DIN 8 pin) ‘4

© Auditdata - 2024, 1D: 20.0109/22

19



Instructions for use

No

Table: Connectors for use in the Fitting
Unit (plug/type in parenthesis)

Name on the Fitting Unit (and
colour of transducer connectors if
highlighted)

*4

17

High-frequency air conductor (DIN 8
pin)

Air Conductor 14
Air Conductor 274

Air Conductor 3

18

Bone conductor (DIN 8 pin)

19

Client Response push button (DIN 8
pin)/Free field calibration tool (DIN
8pin)

Client Response

20

Probe microphone set (DIN 8 pin)

*2

*3%4

*1 This plug is only available in the PFU.

*2 This plug is only available in the PFU+.

*3 This plug is only available in the Primus Pro.

4 Frequency above 8 kHz will be unavailable.

© Auditdata - 2024, 1D: 20.0109/22
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2000-1 Fitting Unit

10 11

[ 111

DC Right Left  Line Out

. @ Free Field Speakers SPDIF .

1 R R
| BC Client

| Response

°

Option

>

30—

12hk—ﬁ;\

\

REM

h

Operator
Microphone

Monitor
Headset

| Talk Back

<r

antiont (o)

14

I

13 J Microphone

—

I

Microphone \:j

15

Table: Connectors for use in the Name on the Fitting Unit (and
NO Iritting Unit (plug/type in parenthesis) [C0/0Ur Of transducer
piug/typein p connectors if highlighted)
Bone conductor (Mini DIN 8 pin) BC (Green)
Air conductor (Mini DIN 8 pin) .
High-frequency air conductor (Mini
3 DIN 8 pin) AC HF (Yellow)
4 REM probe microphone set (Mini DIN _
8 pin)
5 | Option (DIN 8 pin) Option (Purple)
Client Response Push Button (Mini
DIN 8 pin) OR
6 Client Response (Grey)
Free field calibration tool (Mini DIN 8
pin)
Free Field Speaker, right (passive . .
7 type) (Anitek, H5-02-1-0-5-0) Free Field Speakers, Right
Free Field Speaker, left (passive type) .
8 (Anitek, H5-02-1-0-5-0) Free Field Speakers, Left
Free Field Line Out (3.5 mm Stereo
9 Mini Jack for connecting active Line Out / SPDIF
speakers or amplifiers) OR
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Table: Connectors for use in the Name on the Fitting Unit (and
No Fitting Unit (plug/type in parenthesis) colour of transducer
plug/typein b connectors if highlighted)
SPDIF: Sony/Philips Digital
Interconnect Format (toslink)
10 USB cable (USB type C) USB
11 DC power adapter (pin/hole) DC
1 Operator heac'zls.et for monitoring (3.5 Monitor Headset
mm Stereo Mini Jack)
Talk-back microphone (3.5 mm .
13 Stereo Mini Jack) Talk Back Microphone
Operator microphone, left (3.5 mm .
14 Stereo Mini Jack) Operator Microphone
15 Connector not used Ambient Microphone
Primus Ice

10 1"
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Table: Connectors for use in the Fitting Name on the Fitting Unit (and .
No Unit (plug/type in parenthesis) colour of transducer connectors if
plug/type In p highlighted)
1 DC power adapter (pin/hole) DC power
2 USB cable (USB type B, 2.0) USB
3 Free Field Speaker, left (passive type) Left
(Anitek, H5-02-1-0-5-0)
4 Free Field Speaker, right (passive type) Risht
(Anitek, H5-02-1-0-5-0) &
Operator microphone (3.5 mm Stereo .
5 Mini Jack) Operator Microphone
Free Field Line Out (3.5 mm Stereo
6 Mini Jack for connecting active speak- | Line Out/Demo
ers or amplifiers)
7 Tglk_—back microphone (3.5 mm Stereo Talk Back Microphone
Mini Jack)
3 Operator heagls.et for monitoring (3.5 Monitor Headset
mm Stereo Mini Jack)
9 Air conductor (DIN 8 pin) Air Conductor
9 H.|gh-frequency air conductor (DIN 8 Air Conductor<1
pin)
10 | Bone conductor (DIN 8 pin) Bone Conductor
Client Response push button (DIN 8
11 | pin)/Free field calibration tool (DIN Client Response
8pin)

*1 Frequency above 8 kHz will be unavailable.

9. Connect the speakers into the speaker inlets.

10.

11.

entanglement) to personnel or clients.

12.

Close the Fitting Unit using the lid.

Optional: Connect the operator microphones, headset and additional freefield speakers
to the appropriate sockets (see the above lists).
Make sure that all cables are routed and fastened to prevent a hazard (such as

Note: The unit has no physical user interface (apart from the on/off lamp, which is visible
through the lid itself). Hereby, in order to protect it from dust and unintended disassembly, it is
recommended to keep the lid on during use.
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8.1.3 HIT Unit setup procedure

1. Place the HIT Unit on a stable surface.

2. Connect the USB cable to the inlet marked USB on the HIT Unit. Connect the other end
of the USB plug into an empty slot on the operator PC. Connect the power adapter to the
DC inlet, if performing tests are up to 16kHz.

3. To adjust hearing aid settings with HI-PRO or NOAHIink™, connect the HI-PRO box or
NOAHIink™ to the appropriate INTERNAL HI CONNECTOR outlet using the extension
cables provided (as shown in the picture below).

HIT Box HIT Pro

f

DC  USB Left Right Monitor

4. Plugin the hearing aid programming lead to start programming with a HI-PRO or
NOAHIink™.

Note: You can also connect the HI-PRO box or NOAHIink™ directly to the operator PC.
The plug in the hearing aid programming leads directly to the HI-PRO box.
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HIT Box HIT Pro

5. Optional: Connect a monitor headset to the MONITOR socket.

HIT Box HIT Pro

DC use Left Right Monitor Monitor  Left Right USB DC

Internal HI connector Internal HI connector

[ olee @J [ oon}

6. Plugthe reference microphone, coupler and battery pill in the inlets as shown below.
You can also place the necessary sponge provided to support the hearing aid. Please
refer to Section 9.2, Set up and editing for hearing instruments in the User Manual for
more information.

HIT Box HIT Pro
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No Name

1 | Coupler microphone

2 | Battery pill

3 | Hearing aid programming lead (HI-Pro cable)
4 | Reference microphone

5 | Hearing aid holder

6 | Coupler microphone holder

8.2 Software Installation

8.2.1 Prerequisites

At least version 4.7 (or higher) should be installed if you are using NOAH.

8.2.2 Installation Procedure

You will receive the software installation file on a USB memory stick. Insert the USB stick into a
USB slot.

The installation should now start automatically. Follow the instructions on the screen.
If the installation does not start automatically, do as follows:

1. Open Windows Explorer and locate the USB stick.

2. Locate the setup_x.x.x.x.exe file and double-click it.

3. The installation program will now guide you through the installation procedure.
4. Follow the instructions on the screen.

Note: Starting from version 2.1.0.0, you will need to install an additional driver for the Video
Otoscopy module. During the installation of the software, you will be asked to allow the
installation of these drivers. You must click Install or the installation will be cancelled.

8.2.3 Updates

When a new software version is available, you can download it from the Internet. Open
Auditdata A/S' homepage, www.auditdata.com from the Support section.
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8.3 Installing Your License

8.3.1 Cloud-based License Activation

For Auditdata Cloud solution users, the system will automatically download and install licenses.
Ensure the hardware is connected to the computer and there is an internet connection. You will
see a notification once the license has been successfully added. To complete the installation,
restart the application.

8.3.2 Manual license activation

If the application cannot download the license from the cloud, you can manually enter the
license code:

1. Inthe License Notification dialog box, click Show License Info.
2. Inthe License Information dialog box, go to the Licenses tab.

3. You have two options: Import and Enter Code.

w oo e Licenses
by Module
L L b aine Bt apie sl A Trow
| e | meon Jemercoe | e

e Click Import to navigate to the location of the license file, then click Open.

¢ If you have the license code, click Enter Code and enter your unique key, then
click OK.

4. Restart the application to complete the installation of the license.
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8.3.3 Calibration and Adjustments

After completing the software installation and hardware setup, proceed to calibrate the free
field loudspeakers (if any) and make an initial adjustment of the attached microphones and
headsets. After calibration and adjustment, the system is ready for use.

To view information on connected devices and calibrations, go to Tools > Device Management.

8.4 Test Definitions Set-Up

Test definitions are pre-configured measurements based on the test types available within the
system. You can locate them by opening Tools and then clicking Test Definitions.

Use the Add, Edit and Remove buttons to set up test definitions for the main modules, namely:
Audiometry, Real Ear Measurement, Speech Mapping and HIT.

@ Test Definitions - 0o X

[ Test Definitions Pure Tone

@ Pure Tone Name Description

3 Speech NSE o

68 REM MCL Remove
8% Speech Mapping ucL
@ HIT Neo -
= Workflows c
CLA
6% Workflows WER
= General SISl
83 Set Password Stenger
8% Common

Close

You can create and name new custom test definitions for each measurement by configuring the
signal type, level, transducer, masking stimulus for each test.
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@ Editor For Test Definition X

General Frequencies Curve Styles Rules Masking assistant
Name [HTL |
Description H |

Test Type HTL

Stimulus Masking | Masking '|
Signal Type ‘ Pulsed Pure Tone v ‘ Signal Type | Narrowband Noise V|
Transducer ‘ Insert Earphone [NOT CONNE + ‘ Transducer | Insert Earphone [NOT CONNE ~ |
Interrupter ‘Sh’muli when pressed v ‘ Default Level, dB 50 .

Default Ear Side ‘ Right v ‘ Masking Side | Opposite v |

Level Preselection Other Settings
Start Level 50 . Step Level | 5dB V|
Reset Mode ‘ No Level Preselection v UCL Limiter | None v |
Reset Level .

|| Minimum point repetitions for threshold

Repetitions needed 2

1

dB Reset

o -]

Cor | o |

It is also possible to specify the completeness criteria by checking that the selected frequencies

are measured during the test.

Enable consistency criteria to check whether AC and BC thresholds need to be masked. Also,
check that the threshold levels are according to the following rule: UCL > MCL > AC >= BC.

v/ Enable mandatory frequencies check

Check that the following frequencies are measured:

[J125 [l 250 [v| 500 1750
13000 |+ 4000 (1 6000 (v 8000
["112500 "] 14000 [~ 16000

Consistency check

[+ UCL > MCL > HTL 2 BCL

|| Check that stimulus was played before store
|| Enable interoctave frequencies check

Check that the following frequencies are measured:

[ 1750 | 1500 [ 13000 |1 6000

|| Enable ambient noise monitoring warnings

Maximum permitted uncertainty

|| Stop measurement when ambient noise is high

o Editor For Test Definition X

General Frequencies Curve Styles Rules Masking assistant

[v/ 1000 1500 [+ 2000
|_I9000 [l 10000 111200

Threshold value dB HL
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More details about setting up various modules can be found in the System’s Help.

8.5 Configuring Types of Visits

The Types of visits list itself is available right below the Client tab.

File View Tools Help

B0 &

® Doe John
0000002
6/1/1986

Male

First visit -

First visit
Follow-up Visit
Last Visit

HIT 1

HIT 2

e — =

The application is shipped with a set of predefined visits. You can add, delete or edit them. To
do this, open the Tools menu, click Settings, then Workflow in the General section, and use
Add/Delete/Edit buttons as needed.

If you do not wish to use some of the modules, you may disable it by deselecting the check box
under the Enable modules heading. Those modules will now not be shown in the workflow list
on the main screen.

Enable modules

v| Otoscopy

v| Tympanometry

v| Audiometry

v| Hearing Loss Simulator and Master Hearing Aid
v| REM

v| Speech Mapping

v HIT

Each task group consists of relevant tasks which you can select using the arrow buttons to
move to the selected tasks box to add to your workflow. Once you have selected all your tasks
required, use the Up and Down button to change the order of your selected tasks.
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In the main window of the application, the task groups are represented by the tabs located right
below the task list.
® Doe John

0000002

Male

37

‘ First visit v

> F Otoscopy

= Tympanometry
p-m-N

n F Pure Tone
= Speech
Audiometry tasks |
(( o imul...

= Master Hearing Aid

Q R REUR/REUG
) R REAR-65

ollo
J°

8.6 Activating Workflow Support

The system includes a workflow support utility which guides you through the necessary
measurements step by step. The purpose is to provide the ability to follow company defined
test protocols and open the particular test steps in their predefined configuration. For each
workflow step you can define type of measurement, stimulus, level, frequencies, etc. It is
possible to set each workflow step as an optional or mandatory step.

You can define as many workflows as you want depending on your needs. However, only one
workflow can be activated at a time.

To enable workflow support, go to Tools and select Settings where you click the Workflow tab.
Select the corresponding check box to activate workflow support.
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@ Settings
= General
i& Network
i§3 Common
3 Database
i@ Language
2 Client Information
@ Workflow
i§3 Measurement
8% Reporting

& CD and Media Files
Folders

i@ Key Mapping Manager

i& Loudspeaker selection
5 Got

2 GDT Interface

i@ Additional Information
[ Ambient Noise Monitoring

8 ANM Setup

i§3 ANM Default Values
= Audiometry

i@ Default Views

2 Controls

82 Measurement Standard

2 PTA/CPT

oo

" [ workflow Settings

System Settings
| Activate workflow support
Note: Activating workflow support will hide the short cuts selected for the types of visits and

will disable the selection below. Define Workflow steps from the Tools menu entry "Test
Definition".

Types of Visits
First visit (default)
Follow-up Visit
Last Visit
HIT1
HIT2

Enable modules

[v| Otoscopy

[v| Tympanometry

[v| Audiometry

|| Hearing Loss Simulator and Master Hearing Aid
(vl REM

[v| Speech Mapping

[w] HIT

Save Cancel

Note: Activating workflow support disables the types of visits functionality in the user interface.

To configure workflows, go to Tools -> Test Definition. Select a workflow entry from the list and
click Edit to open it. Use the buttons in the right panel to add new workflows, edit existing ones
or delete any workflow from the list.
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O Test Definitions - O

X

[ Test Definitions Workflows

1 Pure Tone Name Description Add

i83 Speech Basic Audiometry Test

i§3 REM Hearing Aid Transition

i@? Speech Mapping

82 HIT Up
= Workflows

Edit

Remove

:53 Workflows
5 General

83 Set Password

i@? Common

Close

To define the steps within the workflow, click the Edit button to open the configuration window.

€ Editor For Workflow

X

Workflow Name | Basic Audiometry Test

Description

Workflow Steps Name Description Mandatory

Pure Tone (AC)  Pure Tone testing via air conduction Yes

Edit

Pure Tone (BC)  Pure Tone testing via bone conduction Yes

. Remove
SRT Speech Reception Threshold test No

sD Speech Discrimination test No u

As you add the steps, you need to specify the test type, set its prospected duration and set test
step as mandatory or optional.

Note: There are three specific step types that display a message to the audiologist, prompt
them to enter a note, open an external file (website or presentation), called Display a message,
Prompt a user to add a note, and Open External Link correspondingly.

After restarting the software, you can find the workflow on the top panel of the application.
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-
0 “@ae0

"y Address |

After the workflow support has been activated, click the Start button to begin. The first workflow
step will be highlighted and after clicking on it you will be directed to the corresponding module
and the preconfigured test will open up. Each step is coloured according to its state:

Yellow - Incomplete
Green - Done

Red - Skipped

Dark Grey - Active Step
¢ Blue - Not Done

Workflow: Basic Audiometry Test | Finish | | Next Step *Pure Tone (A... - *Pure Tone (BC)- SRT - sD I

If the criteria for the test type are not fulfilled, the application will notify you when you attempt
to move to the next step. You can see what criteria was not met and make required changes to
the measurement.

You must enter a reason why the criteria cannot be fulfilled or change the test to meet the
criteria requirements.

8.7 Activating Transducers

The transducers used with the Fitting Unit need to be activated before usage. To start the
activation:

1. Runthe application.

2. Insert the transducer plug into the appropriate socket.
3. Inthe pop up window click Activate.

4. Your transducer is now activated.

8.8 Connecting Transducers to a Sound Booth

To connect a transducer to a sound booth, please do the following;:

1. Runthe application and plug in the transducer into the Fitting Unit.
2. Disconnect the transducer. Do not restart the software.
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Plug in a sound booth cable into the same plug that was used for the transducer.
The system will show the dialog with data from the last connected transducer.
Verify that the right transducer is connected.

You can how connect your transducer to a sound booth.

o0k w

8.9 Calibration of Free-Field Loudspeakers - Sound Field Cal-
ibration

Free-field loudspeakers must be calibrated before performing any audiometric testing.

The calibration of the free-field loudspeakers is only valid for the exact distance from the
client's ear for which they are calibrated at.

Therefore, free-field loudspeakers should be re-calibrated if they are moved from the exact
location at which they were calibrated.

For the following procedure it is assumed that the connected loudspeakers are of a high quality,
particularly with respect to linearity and maximum sound pressure.

Procedure

1. Place the free-field loudspeakers at a distance no further than 1 m and angle the
speakers, for example at 45° or O° azimuth from where the client's ear will be during
tests. The center of the loudspeaker should be at the same height as the ear canal.

Note: The calibration must be repeated if the client has moved from the original calibration
distance.

2. Inthe case of active loudspeakers, make sure that the volume is set to maximum.

Note: Some active loudspeakers may be too sensitive and will produce distortion noise,
when set at maximum volume. In that case, try to reduce the volume (if max. output can be
reached) until you find a level where max. output level can still be reached and noise from
the loudspeaker system is acceptable.

3. Open the Fitting System program, go to Tools > Settings > General > Loudspeaker
selection and select the correct speaker for pure tone, speech, REM, and SM according to
your setup.
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@ Measurement

[v| Play Windows sounds through speakers

0 Settings - 0O X
[ General Loudspeaker selection
8 Network Workstation Settings
Pure tone ‘ Free Field Loudspeakers A | ‘ Left and Right Speakers V‘
i?}'i Common
@ Database Speech ‘ Free Field Loudspeakers v | ‘ Left Speaker v‘
8 Language REM ‘ Free Field Loudspeakers v | ‘ Right Speaker v‘
8% Client Information SM ‘ Free Field Loudspeakers v | ‘ Right Speaker "
£ Workflow Percentile Free Field Loudspeakers ‘ Right Speaker v‘

8% Reporting [v| Room Equalization in REM

@ CD and Media Files
Folders

@ Key Mapping Manager

i@ Loudspeaker selection

Click Save to confirm the specified settings.
Select Sound Field Calibration from the Tools menu.

The window contains the history of performed calibrations. Click Do Calibration to start a
new calibration.

Note: A password is required to access this function. Enter the following password -
"orimusFFcal".

In the Calibration of Free Field Loudspeakers dialogue box, enter the name of the
technician who performs the calibration, select the module you want to calibrate and a
calibration method.

@) calibration of Free Field Loudspeakers X

Technician Name |Jennifer Hutchinsor‘ ‘

Select modules for calibration:
|w! Pure tone audiometry
["] Speech audiometry
|| REM/SM

Select Calibration Mode

_) Using REM reference microphone
®) Using free field calibration tool

) Using external SPL meter

If you have selected external SPL meter, in the next Setup window, select the speakers you
wish to calibrate.

Also check-mark the box at the bottom if the calibration should include the high-frequency
area.
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10.
11.

12.

13.

14.
15.

Note: High frequency calibration option is only available when the pure tone audiometry
module is selected.

If you are using the built-in microphone, select Left or Right Probe-mic to measure the
levels with.

Note: The REM probe microphones must be calibrated before being used to calibrate the
loudspeakers.

If you are using the free field calibration tool, levels will be measured with the free field
calibration microphone.

Note: When using the Primus Ice, you should calibrate by selecting the external SPL meter
or the free field calibration tool.

Set the level you wish to calibrate at.
Select Speech Noise- ILTASS for signal for sound card calibration.

Place the SPL meter, free field calibration microphone, or Real Ear Probe at the exact
location where the client's ear will be tested.

Observe the instructions at the top of the Setup window, and click the Start button. (You
will get a warning, if any selected instruments are not connected and turned on).

If you use the SPL meter, you will need to set the level manually, using the correction
values shown in the image below. If you want to add 2 dB to the level, for example, just
press +1 twice. Once you are fine with the level, click the Next button.

When using "Built-in Microphone" or free field calibration tool, and more than one speaker
were selected, the procedure will continue automatically for other loudspeakers. If one or
more frequencies cannot be calibrated, a warning will appear. At the end of the calibration
a report will be displayed, showing any uncalibrated frequencies or levels.

Click OK to save the calibration and exit the Loudspeaker Calibration dialogue box.

By means of markings or fastening, make sure that the loudspeakers will be placed in this
exact position compared to the client's location during testing.

You can import and export calibration data in the XML format using the Import and Export
buttons correspondingly. After you click Import, locate the saved calibration XML file on your PC
and click Open. Proceed to calibration afterwards. To export your calibration data, click the
Export button and save the XML file to your local computer.

Use the Print Report button to print the calibration report.

8.10 Addition of External Sound Files for Speech Audiometry
and Speech Mapping

To add a new media files folder:
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5.
o.

On the CD and Media Files Folders, click Add button to add a new folder with your own
sound files (wav, ogg, wma) or get the files from the Cloud. The Custom Media files
Folder window opens.

Specify the Name of the external folder.

¢ If you are planning on using the speech materials from the Cloud, activate the
corresponding option.

Select the Folder Path where the external folder is located.

Select the CD Scheme that corresponds to your sound files and click the Calibrate
button.

Select the track or special sound which will calibrate your sound files.

Calibrate the selected files and click Save button and then OK to save again.

The calibration of recently calibrated file will be used for all external sound files in Speech
Mapping and Speech Audiometry modules.

Note: Only one calibration value is available and used for all external sound files and will be
applied to all transducers.
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8.11 Calibrating Speech CD Material

To adjust the output level for speech material:

1.
2.
3.

Select Settings from the Tools menu.
In the Settings dialogue box, select CD and Media Files Folders from the General folder.

In CD and Media Files Folders Settings, click the button Calibrate CD... to open the CD
Calibration window.

Adjust the CD Offset to the correct value in dB if the CD contains an offset value.

The value in the field “CD Offset” has only effect on the free field speakers, but not on the
transducers. It will increase or decrease the common reference output level for the sound
field speakers according to the value entered. A change of the offset value does not
influence the VU meter level displayed.

Important Note: The required CD offset value should only be obtained in conjunction with
a proper calibration equipment (sound level meter) to measure the output level of the
sound field speaker.

Warning: Only recorded speech material with a stated relationship with the calibration
signal should be used.

Select the calibration track on the CD and click Start Calibration.

@ Calibration dialog X

Select CD track for calibration:

Disk ‘ © Calibration '|

Track ‘Calibraticn 0:48 '|

CD offset D

Right | ! |
-40 -30 -20 -10 0 10

Left | |
-40 -30 -20 -10 0 10

Csee | oo

During the calibration adjust the level so the VU meter is around O using the ‘+’ and ‘-’
buttons.

6. Click Save to save the setting and exit the dialogue box.
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8.12 Selecting Client and Entering Client Data

If client data has been saved in the Noah database, the client's name will appear in Noah’s
Patient Browser.

To start the program as a Noah module, you have to select the client in the Patient Browser and
then click the software icon in the module list.

The application opens with the client's data displayed in the dashboard of the application.

If you need to create a client in Noah, open the Noah File menu, click Add New Patient, and
then fill in the client data. Please note that fields marked in orange are mandatory.

If the application has been started outside the Noah system, you have to enter the client’s data
first. Open the Tools menu, click Client Information, and then fill in the client data.

Once you click OK, the client’s name, date of birth and some other data will appear in the top
title bar. To choose which information to display in the title bar, go to Settings > General >
Client Information and select the appropriate checkboxes.

O settings - 0O X
= General Client Information Settings
83 Network User Settings
Fields on First Tab
@ Common
5 Datab First Line Client Number v
atabase
&2 Client Information Third Line Age -
@ Workflow - - -
Title bar information
@ Measurement
v| Show client name
Reporti
&2 Reporting v/ Show client number
& CD and Media Files Show NHS number
Folders
v Show birthday
i@ Key Mapping Manager

Alternatively, you can import client data that were previously exported from the application:
open the File menu, click Import Sessions and then specify the location of the XML file with the
client data.

8.13 Obtaining Hearing Threshold Levels

Prior to performing audiometric measurements with your client, please ensure the following:
For the client:

1. The client has a comfortable seating in the sound-attenuating booth.

2. The appropriate testing headsets are plugged into the appropriate sockets.

3. Aclient response switch is connected to the CLIENT RESPONSE socket of the
Fitting Unit.

4. Optionally, a microphone for the client talk-back is connected to the TALK BACK
MICROPHONE socket on the Fitting Unit.
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For the operator:

1. Optionally, a monitor headset with boom microphone can be connected to the
MONITOR HEADSET socket of the Fitting Unit for talk-back monitoring.

2. Optionally, a separate microphone is connected to the OPERATOR MICROPHONE
socket for talk-over monitoring.

Click on the icon on the Audiometry tasks tab in the application to open the Audiometry front
page in the dashboard.

Doe John 4
0000002

Male

37

‘ First visit v

I P Otoscopy

E' R Tympanometry
F-m-N

n F Pure Tone
R Speech

Audiometry tasks |
( o Simul...

P Master Hearing Aid

(O
=
Q F REUR/REUG
.1 P REAR- 65

ollD
g‘l)@i

Click the Pure Tone Measurement button (| Pure Tone Measurement |) in the Audiometry pane of the
dashboard to open the Pure Tone Measurement window.

Make sure that HTL is selected in the Test Types panel in the top left corner of the window.

@ Pure Tone Measurement

()v @ @ Dual *J HL v m B Extended Range EXlEiTH + § None v

4 Test Types Right Ear

O X HTL -10 HTL—2
M M MCL % ek

U U uc °

< > BCL 10 /
S S FF = @

@ % FF-A

O X WEBR 30

®® Stenger

Add measurement ... ¥

20

To select the HTL test type, simply click it. Alternatively, you can press the T button on the
keyboard.
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Check the settings on the Measurement Controls panel below the audiograms:

1. Select ear by means of the blue (@ ) or red button (@ ). Alternatively, use the L button
on the keyboard for the left ear and the R button for the right ear.

2. Set frequency and amplitude by means of the "+" and "-" buttons. Alternatively, use the
arrow left/right and up/down buttons of the keyboard.

3. Configure the necessary masking settings.

4. If you need to adjust the talk-over/back levels, click the Settings () button to open

this setting menu.

For a complete list of keyboard shortcuts, please refer to the Help file. To open it, go to the Help
menu of the application and click Get Help; alternatively, press F1 on the keyboard.

Click the Stimulus button, or press the spacebar on the keyboard, to present a signal to the
client. When the client is capable of catching the signal of a certain frequency and level, he or
she responds by using the response switch. When this happens, the colour of the Frequency
Levels pane changes.

| Right Insert [NC] v ‘ | Left Insert [NC] |
-5deHL T 1000 Hz ®
| Pulsed Pure Tone A ‘ | Narrowband Noise '|

Click the Store button, or the S button on the keyboard, to mark the point in the audiogram.
Refer to the Help file for a detailed description of the procedure.

When you have obtained all required data for both ears, click Save—the button is active if the
program is opened as a Noah module—and then Close, in order to save your measurement
data.

After that, a corresponding item appears in the Measurement History pane of the dashboard. If
you place the mouse pointer over the history item, the corresponding audiogram will be shown
in a large format.
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e Measure
File View Tools Help

® 0 AHa @
®b

Audiometry
Date: 9/13/2023 3:43:00 PM

oo b

= Pure Tone
e g

—M 26
20 ©
ﬂ . 30 m\\( -
Note: o
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©, o
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70
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dB HL

olln o
110
Chyte
:m 120
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125 250 500 1K 2K aK 8K
Frequency
2/21/2023 Pui
10:42:56 PM
X HTL PTA: 23
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You can double click any measurement from the session list to display it in the workspace.

From the Measurement History pane, it is also possible to print a selected measurement by
employing the corresponding button.

The Print option enables printing reports for the current or any of the older sessions. For REM,
SM and HIT measurements, the only default report type will be printed. As for the Audiometry
Reports, you can choose between a number of available options in the Print Options section
that is accessible via Settings > General > Reporting.
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8.14 Shutdown Procedure

Closing Application
To safely close the application:

1. Select File > Exit or use Alt+F4. If you made any measurements, the system will show
the warning:

@ Warning X

The application contains unsaved data.
Do you want to save the data before
you exit?

B T

2. Click Yes to save the session data and close the application. Click No if you want to close
the application without saving of data.

Disconnecting Fitting and HIT Units

For the Unit that uses the Opto-USB cable without power DC adapter: disconnect the USB cable
from the instrument and the USB power supply from the mains power outlet.

For the Unit that uses DC adapter and non-optical USB: disconnect the USB cable from the
instrument and then disconnect the DC adapter both from the instrument and the mains power
outlet.

For the Unit that uses non-optical USB without power DC adapter: disconnect the USB cable
from the instrument.

For the Unit that uses the Opto-USB cable and power DC adapter: disconnect the USB cable and
the USB power supply from the mains outlet and then the power DC adapter from the
instrument and the mains power outlet.

9 Maintenance

9.1 Annual Calibration of Headset and Transducers

The headset and transducers delivered with the Fitting System and reference and coupler
microphones delivered with the HIT Unit are NOT intended for calibration by users. Contact your
local distributor for your annual service and calibration.

9.2 Adjustment of Common Headsets and Microphones

All calibration of the Fitting System and transducers delivered with the system has been made
by the manufacturer before shipment. The system’s accessories should be re-calibrated
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annually by the supplier or their appointed representatives to ensure system integrity.

Depending on your license agreement, however, you may have access to perform calibrations
locally. In this case some extra options, like Headphones Calibration, REM Calibration, and HIT
Microphone Calibration, can be done with a separate calibration tool.

9.3 Regular System Checks
9.3.1 Adjusting Speech Audiometer input level

Prior to speech testing, it is recommended to check the VU-meter for proper sensitivity level. For
this, you should play a CD calibration signal and adjust the input sensitivity to O dBVU.

9.3.2 Calibration of probe tube and reference microphone (in REM and SM)

Prior to real ear measurement session or when replacing the probe tube with a new one, ensure
the correct probe tube calibration. If it is calibrated properly, you should see a flat curve once
measuring a REUG with the probe tube still kept in the calibration position.

9.3.3 HIT box calibration

On a regular basis (e.g. once per day), check the proper coupler microphone sensitivity and
calibration. The procedure is as follows:

1. Unscrew the coupler microphone body to expose the coupler microphone diaphragm.
2. Place it close against reference microphone without it touching.

3. Conduct an OSPL90 measurement, you should see a flat line at 90 dB.

9.4 Inspection

On a regular basis, that is, at least once a week, perform a visual inspection of the Fitting and
HIT Units and their accessories for visible damages. During use, evaluate the test results and
perform a system inspection if the results appear unreliable.

9.5 Cleaning
9.5.1 Disposable parts

@ Parts such as foam tips on insert earphones or probe tubes for real-ear measurement are
not intended for reuse. Dispose of such items in a hygienic manner after each client session.

9.5.2 Reusable parts

Maintain a high level of hygiene and clean reusable devices which come into contact with
clients between each use. See the cleaning instructions below.
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9.5.3 Cleaning instructions

For cleaning use only a soft dry cloth dampened very sparingly with a low level
disinfectant solution such as isopropyl alcohol to wipe the device. Do not allow excess
solution to enter the device as this may damage internal components.

Do not autoclave, pressure sterilise, or gas sterilise the device or any of its electrical
accessories.

Do not soak or immerse the device in any liquid.

Do not use acetone or paraffin/kerosene-based solutions, or any other harsh solvent to
clean the device or its accessories. Use of such substances may be harmful to the
equipment and may result in faulty operation.

9.6 Switching to a new transducer

When setting up a new transducer, make sure that it is recognized by the Fitting Unit. To do so,
follow the instructions:

1.
2.

A L

10.

Connect the Fitting Unit to the PC using the USB cable.
Start Measure.

Wait until the Fitting Unit is initialized and connected. The current connection status is
displayed on the right side of the status bar at the bottom of the screen.

Disconnect the old transducer.

Connect the new transducer to the Fitting Unit.

In Measure, go to Tools > Device Management.

Review the name and serial number of the new transducer.

If the data corresponds to the new transducer, you can start using the system normally.
If the data corresponds to the old transducer, proceed with the next steps.

In Measure, go to Tools > Refresh Transducer Data.

Select the needed transducer and click Refresh Transducer Data.

The system will inform you once the process is finished. You can close the window and
start using the system normally.
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10 Troubleshooting Guide

If you have any problems with installing or running the software, please go through this guide
first before contacting a Support/HOT-line.

Please verify that the following installation prerequisites are satisfied:

¢ The Fitting System software supports Windows 10, Windows 10 Anniversary Update and
Windows 11 operating systems.

¢ Local administrator rights are required in Windows to install the Fitting System software.

¢ The Fitting System software supports NOAH 4 or higher.

Before starting the troubleshooting - please ensure that you do the following steps:

¢ Unplug the USB cables and power supply (if available) from the Fitting/HIT unit.
¢ Re-start the computer.
¢ Connect the Fitting/HIT unit to the computer using the USB cable.
¢ Connect the power supply to the Fitting/HIT unit, if available.
e Check that all available headsets, speaker and other accessories are connected to the
Fitting/HIT unit.
¢ Run the Fitting System software.
¢ Check that the Fitting/HIT unit is connected properly:
¢ In the Fitting software status bar the device is shown as Connected:

Status @ PFU+ HW: Connected 9 HW: Not Connected

¢ Power light on the Fitting/HIT unit is permanently on.

If any of the above steps failed, please refer to the below table for the solution of your problem.

Problem Action
Software installation problems

e Setup can’t be completed

¢ Use only the supported Windows operating
successfully (when running

systems.
the setup_x.x.x.x.exe). * Use the latest Windows service packs.

Software set-up problems

e The stimulus button in the
Audiogram is greyed out.

¢ At start-up of the Fitting
System the “License
notification” message is
shown.

¢ The License code is not activated. Please activate
the license from the help menu and follow the
description for the activation of the license code.

Hardware connection problems

¢ In the Fitting Software ¢ Reconnect a USB cable and power supply, if
System’s status bar under available. Check that the units are connected. (See
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Problem

Action

“AUD HW/ HIT HW” it says:
“Not connected”.

the status bar in the software).

¢ Try another USB port on the computer.

¢ Try another USB cable.

¢ |If connection is done via hub/switch, connect
directly to computer.

* No sound in headset or
speakers, etc.

e Ensure that the unit is connected to the computer
using the USB cable.

e Power light is steady on.

¢ Plug and unplug all headsets.

¢ Reconnect USB cable and power supply, if
available. Check that the units are connected. (See
the status bar in the software).

¢ No output from the speaker
in REM.

Ensure that you have selected the correct speaker in the
Tools > Settings > General > Loudspeaker selection >
REM. Then calibrate your REM probe tube.

e Power light is not steady at
start-up of the Fitting
Software System.

e Re-start the Fitting Software System.

¢ Reconnect USB cable and power supply, if
available. Check that the unit is connected. (See
the status bar in the software).

e Check that the unit is displayed in Windows device
manager under sound devices. If not, please
contact support.
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11 Hotline and Technical Support

Auditdata A/S, Wildersgade 10B, 1408 Copenhagen, Denmark. Phone +45 70 20 31 24
support@auditdata.com

UK Responsible Person:
Auditdata Ltd., Staines-upon-Thames, UK. Phone +44 (0) 333 4444 212.
support@auditdata.com

Australia Sponsor:
Daryl Staley-Jackson, 247 Creek Ridge Road, Glossodia, NSW, 2756, Australia.
support@auditdata.com

US:

Auditdata, LLC, 88 Glocker Way, #352 Pottstown, PA 19465. support@auditdata.com
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Appendix A

A.1 Declarations of Conformity
Primus Fitting Unit+ (PFU+)

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Manufacturer name and Auditdata A/S
address Wildersgade 10B
1408 Copenhagen
Denmark
Notified Body name and TUV SUD Product Service
address GmbH C E
Ridlerstrasse 65 0123
80339 Munchen
Product Identification MD Category: Hearing Medical Diagnostic (Hardware
and Software)
Trademark: Primus PFU+
Type/Model: Primus Fitting Unit - PFU+ (PFU+)
CS (Common specification) N/A no common specification has been
published
SRN: DK-MF-000011415
Basic UDI/DI: 05711781DHF2000ZC
Risk class: lla, rule 10
Lot/Batches/Serial All issued serial numbers from
number: 21000001
Intended purpose Audiometer is a device used for evaluating hearing acuity. The

audiometer records the subject's responses to produce an audiogram
of threshold sensitivity, or speech understanding profile. Audiometer
with stated accessories is indicated for non-continuous, noninvasive
air and optionally bone conduction and speech audiometric testing.
Audiometer is indicated for non-continuous real-ear measurements
(REM) at the ear drum by means of noninvasive external ear canal
insertion of a probe tube.

Conformity assessment Annex IX (Quality system and technical documentation assessment)
EC-Certificate No.: G10 076081 0015
DOC valid until 2029-02-18

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA/RA Manager
X o

v .
/ 1/
! %‘
%

/

1D: 30.0241/09
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2000 Primus HIT Pro

Manufacturer name and
address

Notified Body name and
address

Product Identification

Intended purpose

Conformity assessment

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Auditdata A/S
Wildersgade 10B
1408 Copenhagen
Denmark

Danish Health and
Medicines

Authority

Axel Heides Gade 1
2300 Copenhagen S,
Denmark

MD Category:
Trademark:
Type/Model:

CS (Common specification)

SRN:
Basic UDI/DI:
Risk class:

Lot/Batches/Serial
number:

C€

Hearing Medical Diagnostic (Hardware)
Primus HIT

2000 Primus HIT Pro (Unit), 2005 -1 HIT
Unit

N/A no common specification has been
published

DK-MF-000011415
05711781DHF2000ZC

I, rule 13

All issued serial numbers from
32000001

The HIT Unit is intendent to apply sound to the hearing aid in a closed
test box and obtain the acoustical output of the hearing aid in a
coupler cavity equipped with a microphone.

The HIT Unit is intended to be used together with the Software to
provide objective indication of the characteristics of a Hearing Aid.
Visualization of the obtained coupler microphone signal is only
available in the Software application.

The HIT Unit is indicated for technical quality inspection or fitting of
hearing instruments with no clients involved.

Annex |, Il and 111

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, May 26t 2024

Denys Lebedev, QA/RA Manager

ID: DN00969/06
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2000 Primus Fitting Unit Pro

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Manufacturer name and Auditdata A/S
address Wildersgade 10B
1408 Copenhagen
Denmark
Notified Body name and TUV SUD Product Service
address GmbH
Ridlerstrasse 65 0123
80339 Munchen
Product Identification MD Category: Hearing Medical Diagnostic (Hardware
and Software)
Trademark: Primus Pro
Type/Model: Primus Fitting Unit Pro (2000 Primus

Fitting Unit Pro, PFU Pro)
CS (Common specification) N/A no common specification has been

published
SRN: DK-MF-000011415
Basic UDI/DI: 05711781DHF2000ZC
Risk class: Ila, rule 10
Lot/Batches/Serial All issued serial numbers from
number: 25000001
Intended purpose Audiometer is a device used for evaluating hearing acuity. The

audiometer records the subject's responses to produce an audiogram
of threshold sensitivity, or speech understanding profile. Audiometer
with stated accessories is indicated for non-continuous, noninvasive
air and optionally bone conduction and speech audiometric testing.
Audiometer is indicated for non-continuous real-ear measurements
(REM) at the ear drum by means of noninvasive external ear canal
insertion of a probe tube.

Conformity assessment Annex IX (Quality system and technical documentation assessment)
EC-Certificate No.: G10 076081 0015
DOC valid until 2029-02-18

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA/RA Manager

o~

ID: DN01781/02
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2000 Primus Audiometer Unit Ice

Auditdata
DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Auditdata A/S
Wildersgade 10B
1408 Copenhagen
Denmark

Manufacturer name and
address

TUV SUD Product Service
GmbH

Ridlerstrasse 65

80339 Munchen

Notified Body name and
address

Product Identification MD Category:

Trademark:
Type/Model:
CS (Common specification)

SRN:
Basic UDI/DI:
Risk class:

Lot/Batches/Serial
number:

Intended purpose

C€ .

Hearing Medical Diagnostic (Hardware
and Software)

Primus Ice
2000 Primus Audiometer Unit Ice

N/A no common specification has been
published

DK-MF-000011415
05711781DHF2000ZC
lla, rule 10

All issued serial numbers from
26000001

Audiometer is a device used for evaluating hearing acuity. The

audiometer records the subject's responses to produce an audiogram
of threshold sensitivity, or speech understanding profile. Audiometer
with stated accessories is indicated for non-continuous, noninvasive
air and optionally bone conduction and speech audiometric testing.

Conformity assessment

EC-Certificate No.:
DOC valid until

G10 076081 0015
2029-02-18

Annex IX (Quality system and technical documentation assessment)

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA

e

Py,
e

-

/

A
W
Fibd

/RA Manager

ID: DN00625/07
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2000-1 Fitting Unit

Auditdata

DECLARATION OF CONFORMITY

REGULATION (EU) 2017/745 OF THE EUROPEAN PARLIAMENT

Manufacturer name and Auditdata A/S

address Wildersgade 10B
1408 Copenhagen
Denmark

Notified Body name and TUV SUD Product Service
address GmbH

Ridlerstrasse 65

80339 Miinchen

Product Identification MD Category:

Trademark:
Type/Model:
CS (Common specification)

SRN:
Basic UDI-DI:
Risk class:

Lot/Batches/Serial number:

CE€ o

Hearing Medical Diagnostic
(Hardware and Software)

Measure, Unity 4

2000-1 Fitting Unit (2000-1 FU)
N/A no common specification
has been published
DK-MF-000011415
05711781DHF2000ZC

lla, rule 10

All issued serial numbers for

2000-1 FU from 33000001

Audiometer is a device used for evaluating hearing acuity. The
audiometer records the subject's responses to produce

an audiogram of threshold sensitivity, or speech understanding
profile. The 2000-1 FU with stated accessories is indicated for
non-continuous, noninvasive air and optionally bone conduction
and speech audiometric testing. The 2000-1 FU is indicated for
non-continuous real-ear measurements (REM) at the ear drum by
means of noninvasive external ear canal insertion of a probe tube.

Annex IX (Quality system and technical documentation
assessment)

Intended purpose

Conformity assessment

EC-Certificate No.: G10 076081 0015
DOC valid until 2029-02-18

This declaration of conformity is issued under the sole responsibility of Auditdata A/S.
We hereby declare that the medical device specified above Is in conformity with the
European Regulation (EU) 2017/745 and Directive 2011/65/EU.

Copenhagen, February 19t 2024

Denys Lebedev, QA/RA Manager

1D: DN02476/02
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A.2 Manufacturer

g The Fitting System is manufactured and sold in the EU by:

Auditdata A/S

Wildersgade 10B
1408, Copenhagen
Denmark

Phone: +45 70203124

www.auditdata.com

C€

PRIMUS FITTING UNIT+ (PFU+)

0123

2000 PRIMUS HIT PRO

2000 PRIMUS FITTING UNIT PRO
2000 PRIMUS AUDIOMETER UNIT ICE
2000-1 FITTING UNIT
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A.3 Labelling
Label samples

Measure

M eaS U [ Auditdata

Hearin t & Fitting

are

Software version 6.1.0

AUD & REM

Connected Hardware S/N
Firmware v

Firmware Checksum irmware Checksum

Supported devi

Auditdata A/S
C€os Wildersgade 10B, 1408 K@benhavn, Denmark

Copyright © 2011-2024 Auditdata A/S, Denmark m
‘FMOD Sound System’, copyright © Firelight Technologies Pty, Ltd., 1994-2009.
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Appendix B

B.1 Technical Specification

B.1.1 Fitting Unit

Item

Description

Value

Mechanical Data:

Primus Fitting Unit, without
cover

Primus Pro, without cover

Primus Ice, without cover

External measures Lx W x H
Weight

External measures L x W x H
Weight

External measures Lx W x H

345 x 110 x 35 mm
475 g

345x 112 x 35 mm
500 g

167 x 110 x 32 mm

Primus Pro, with cover

Primus Ice, with cover

External measures Lx W x H
Weight

External measures Lx W x H
Weight

Weight 375¢
Primus Fitting Unit, with External measures LXxW x H 350x 120 x 130 mm
cover Weight 800¢

360 x 120 x 96 mm
900 g

181 x115x94 mm
550¢g

2000-1 FU

External measures L x W x H
Weight

142 x142x55mm 415 ¢

Electrical Data:

%3 Power supply, low

power output

5 volts USB power

max 500 mA

(’,} Provided power
supplies for USB power in
conjunction with OPTO USB
cable (Type OPTICIS M2-
100-03)

type Friwo FW7662M/05

Input voltage 100-240V,
50/60 Hz, 150 mA; output
voltage 5Vdc, 1.1 A

type Friwo FW8002M/05

Input rated 100-240V
+10%, 50/60 Hz, 160 mA.
Output rated 5Vdc, 1.4 A

%3 Provided power sup-

plies for USB power in con-
junction with USB isolation
cable Type IF-TOOLS;
ISOUSB-BOX-PLUS; Art. No.:
14000

The USB Isolator has internal
power supply.

Output voltage 5 Vdc, 0.5 A
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Item

Description

Value

@ Provided power
supplies for high power
output functionality

Direct plug-in power supply, type
Friwo FW7362M/15

Input voltage 100-240 V AC,
50/60 Hz, 700 mA; output
voltage 15 Vdc, 2.0 A

Direct plug-in power supply, type
Friwo FW8030M/15

Input rated 100-240 V
+10%, 50/60 Hz, 300 mA.
Output rated 15Vdc, 2.0 A

Free-field output

w/overload protection

2 channels, each up to 20
watts in 4 ohms *1%4%5

3 channels, each up to 20
watts in 4 ohms *2*3

Left/Right, Sub/Mid, Rear
Free Field Line Out*1*2

Line Out 1/Line Out 2/Line
Out 3 - Free Field Line
Out™3

Line Out/Demo Headset™4

Line Out™®

500 mV RMS

max load 16 ohms

Client*1%2/Demo*3 and
Monitor Headset output

500 mV RMS

max load 16 ohms

Operator microphone Electret microphone powered -40 dB+/-5 dB
inputs (OdB=1V/pa, 1000 Hz)
Talk back microphone Electret microphone powered -55 dB+/-4 dB

inputs

(0dB =1V/pa, 1000 Hz)

REM Probe input

Electret microphone powered
inputs

Refer to sec. B.2.2

Air and Bone Conductor
Outputs

For Tone and Speech:

3 Vrms (w. external power
supply)

1 Vrms (USB only)

125 Hz - 16 kHz Frequency
Range For Bone Conductor:
250 Hz - 8kHz Frequency Range

Max load 4 ohm

Calibration

Refer to a separate manual for

© Auditdata - 2024, 1D: 20.0109/22
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ltem Description Value
calibration instructions.
Tone and Speech signals are cal-
ibrated for Max Hearing Level
Tolerance: +/- 3 dB (up to 8 kHz)
+/-5 dB (8 kHz and higher)
Masking signals are calibrated
for Max Sound Pressure Level
Client response button Normally open contact
Fuses Autofuses
Environmental Data:
Warm-up time (if stored at room temperature) 1 minute
Operating temperature 5°C-40°C
Storage temperature -30°C-70°C
Humidity 5% - 90%

Air pressure (altitude)

70 kPa (3000 meter) to
106 kPa (-400 meter)

Connectors:
@ DC power Pin 2.5 mm/Hole 7.0 mm
Pin: positive supply (+)
Ring: negative supply (-)
. . d 1%2%3%4
> USB 2.0 and USB 3.0 Complies with 60601-1 3" or USB-B* % <% %

IEC 60950-1

USB-C*°

S/PDIF*3%5

Optical Audio

TOSLINK connector*3

Optical Mini Jack 3.5 mm*>®

Left speaker/Middle
speaker/Right speaker

Anitek, H5-02-1-0-5-0

2 pcs*4*5

3 pcs*1#2%3

Line Out 1/Line Out 2/Line
Out 3 - Free Field Line
out*3

Left/Right, Sub/Mid, Rear | Ste"€0 minijack 3.5mm
Free Field Line Out*1%2

Line Out/Demo Headset™

Line Out™®

Operator and talk back Stereo mini jack 3.5 mm

© Auditdata - 2024, 1D: 20.0109/22
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ltem Description Value
microphone input

Client*1%2/Demo*3and | Stereo mini jack 3.5 mm
Monitor Headset output

Air conductor 1 ¥1*2%3%4 | p|N 8 pin
Air conductor*® Mini-DIN 8 pin
Air conductor 2%1#2%3 DIN 8 pin
Air conductor HF*2 Mini-DIN 8 pin
Air conductor 3 (high DIN 8 pin
frequency)*1%2+3

Bone conductor *1*2%3%4 | p|N 8 pin
Bone conductor*® Mini-DIN 8 pin
Client response*1#2%3x4 | p|N 8 pin
Client response*® Mini-DIN 8 pin
Option*2#%3 DIN 8 pin
Option*> Mini-DIN 8 pin
Probe*1/Real Ear DIN 8 pin
Probe*2#*3 input

REM Probe*® Mini-DIN 8 pin
Parts and Accessories*: Description

AUD (in Fitting Unit)

Clinical audiometer

REM (in Fitting Unit)

Real ear measurement unit

Speech Mapping

Speech Mapping with Live voice

and Percentile Analysis

A‘ AUD/REM DC adaptor

15 volts/2A

§ Optical USB connection

Type OPTICIS M2-100-03

Type IF-TOOLS; ISOUSB-BOX-
PLUS; Art. No.: 14000

Headset with microphone

Monitor headset w/boom
microphone for operator
monitoring and talk over

Headset without Monitor headset
microphone
Microphone Table microphone for talk over

or talk back

© Auditdata - 2024, 1D: 20.0109/22
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Item

Description

Value

Extension cord for sound
attenuating booth

Loudspeaker incl. cable

Free-field loudspeaker for real
ear measurement and
audiometry

Insert Earphones

Audiometric insert earphones

Ear tips (small)

Insert ear tips for Primus Insert -
small (children)

Ear tips (medium)

Insert ear tips for Primus Insert -
medium

Ear tips (large)

Insert ear tips for Primus Insert -
large

Insert tube with nipples

For the Insert earphones only.
Length 200 mm

Probe tube guide

Probe tube stabilizer

*1 Only available in the PFU.

*2 Only available in the PFU+.

*3 Only available in Primus Pro.

*4 Only available in the Primus Ice.

*5 Only available in the 2000-1 Fitting Unit.

Applied Parts Type B

R ‘ Note: These parts must only be replaced by identical parts delivered by the manufacturer.

Item

Description

Flex

Insert Phone/Insert Earphone

Real Ear audiometric insert earphones (Model: Realear)

ER-3A Insert Headset

3A)

EarTone audiometric insert earphones (Model: EarTone

ER-3C Insert Headset

Research type 3C)

Etymotic audiometric insert earphones (Model: Etymotic

TDH-39 Headset

Supraaural audiometric headphone

HDA-200 Headset

headphone

Sennheiser circumaural audiometric high frequency

HDA-280 Headset

Sennheiser standard audiometric headphone

© Auditdata - 2024, 1D: 20.0109/22
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Item

Description

HDA-300 Headset

Sennheiser circumaural audiometric high frequency
headphone

DD45 Headset

Interacoustics supraaural audiometric headphone

DD450 Headset

RadioEar circumaural audiometric high frequency
headphone

DD65 Headset

Interacoustics circumaural audiometric headphone

DD65v2 Headset

RadioEar circumaural audiometric headphone

B-71 Bone Conductor

RadioEar audiometric bone conductor

Client response button

Single-button response switch

Free field calibration tool

Free field calibration microphone

Real Ear Probe/REM Probe Flex

REM Probe, binaural real-ear measurement probe set

*) Note: The list of Parts and Accessories is subject to change without notice.

B.1.2 HIT - Hearing Instrument Test Unit

Item

Description

Value

Indoor use

Mechanical Data:

Hearing Instrument Test Unit

External measures L x W x H

350 x 320 x 125 mm

Weight 4.5 kgs
Electrical Data:
Power supply, low power 5 volts USB power max 500 mA

(%3 Provided power supplies

for USB power in conjunction
with OPTO USB cable (Type

type Friwo FW7662M/05

Input voltage 100-240V,
50/60 Hz, 150 mA; output
voltage 5Vdc, 1.1 A

OPTICIS M2-100-03)

type Friwo FW8002M/05

Input rated 100-240 +10%,
50-60Hz, 160 mA. Output
rated 5Vdc, 1.4 A.

(%3 Provided power supplies

for USB power in conjunction
with USB isolation cable Type
IF-TOOLS; ISOUSB-BOX-PLUS;
Art. No.: 14000

The USB Isolator has internal
power supply.

Output voltage 5 Vdc, 0.5 A

@ Provided power supplies
for high power output
functionality

Direct plug-in power supply,
type Friwo FW7362M/15

Input voltage 100-240 V AC,
50/60 Hz, 700 mA; output
voltage 15 Vdc, 2.0 A

Direct plug-in power supply,

Input rated 100-240 +10%,
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Item

Description

Value

type Friwo FW8030M/15

50-60Hz, 300 mA. Output
rated 15Vdc, 2.0 A

MAINS supply voltage fluc-
tuations

up to 10 % of the nominal
voltage

TRANSIENT OVERVOLTAGES

up to the levels of
OVERVOLTAGE CATEGORY II;

NOTE 1 These levels of
transient overvoltage are
typical for equipment
supplied from the building
wiring.

TEMPORARY OVERVOLTAGES
occurring on the MAINS sup-

ply

2 500 V impulse withstand
voltage

Free-field output

w/overload protection

up to 20 watts in 4 ohms

Fuses

Autofuses

Environmental Data:

Warm-up time (if stored at room 1 minute
temperature)

Operating temperature 5°C-40°C

Storage temperature -30°C-70°C

Humidity 5% - 90%

Air pressure (altitude)

70 kPa (3000 meter) to
106 kPa (-400 meter)

Applicable POLLUTION
DEGREE of the intended envir-
onment

POLLUTION DEGREE 2 in
Mmost cases

Connectors:

DC power

Pin 2.5mm/hole 7.0mm
Pin: positive supply (+)

Ring: negative supply (-)

USB 2.0 and USB 3.0

Complies with 60601-1 3 or
[EC 60950-1

USB-B

Left HI-PRO or NOAHIink™
input

6 pin mini DIN
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ltem Description Value
Right HI-PRO or NOAHIink™ | 6 pin mini DIN

input

Monitor headset Stereo mini jack 3.5mm

Parts and Accessories*:

Description

Reference microphone

Installed, Electret goose neck
type

Coupler microphone

Installed, Electret type

Coupler

2 cc coupler with
attachments for ITE, BTE, and
Body-worn Hearing
Instruments

Battery pills, 5 sizes

Type 5A, 10A, 312, 13 and
675

BTE tube PVC tube for BTE Hearing
Instruments. Length 25 mm
ITE putty Putty for fastening of ITE

Hearing Instruments to the
ITE coupler

*) Note: The list of Parts and Accessories is subject to change without notice.
An updated list will always be available from our homepage: www.auditdata.com.

B.2 Technical Data
B.2.1 AUD system

No. of channels:

Full 2 channel

Tone presentation:

Steady, pulsed

Signal types:

Pure Tone:

IEC 60645-3:2007

125 Hz- 16 kHz*

Accuracy within 0.2%
Modulated Tone:

125 Hz - 8 kHz

Triangular linear

10.8 Hz Repetition Rate
+/-10% Frequency Deviation
(of carrier frequency)

Masking types:

Narrow Band Noise:
IEC 60645-1, 1/3 Octave
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filter with geometric center
frequency as the audiometric
TONE frequency

White Noise:

100-20000 Hz with +3
dB/octave throughout its
frequency range

Speech-weighted:

IEC 60645,

125-1000 Hz +3 dB/octave,
1000-6000 Hz - 9 dB/octave

Pink Noise:

100-20000 Hz, +/-1 dB
throughout its frequency
range

Hearing levels:

-10dB-120 dB HL

Deviation, dB: 0.5dB

Distortion: Less than 3 % for air
conduction.
Less than 6% for bone
conduction.

* Primus Ice supports 125 Hz - 8 kHz only.

B.2.2 REM system

No. of channels:

4 channel (2 probe
microphone units with each a
reference mic. and a probe
mic.)

Signal types: White noise, speech-weighted
noise, and pink noise.
For technical specifications
refer to section B.2.1.

Further Signals: ISTS Signal according to IEC

60118-15,

Crest factor: 17

ISTS MPO signal

Peak-Level: 90dB

SPL Frequencies: 0,5, 1, 2, 3,
4 kHz
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On time: 250 ms

Off time: 250 ms

Rise- and fall time: 25 ms
ICRA Signals: (Hearing Aid
Clinical

Test Environment
Standardization)

DSL Signals: Female “S” and
“gH"

(Child Amplification
Laboratory

National Centre for Audiology
Western University London,
Ontario)

Frequency range:

125 Hz - 16 kHz

Signal levels:

50 - 90 dB SPL

Accuracy:

Within 4 dB

Signal Analysis:

Analysis type: FFT

Analysis bandwidth:

125 Hz to 16 kHz

Resolution: 24 bands/Octave
Windowing type: Hann

Equalization type:

Modified pressure method

Sensitivity, Probe Mic.

Depending on selected input
range,

10 ranges available

-35dB (0 dB=1V/pa, 1000
Hz)

Sensitivity, Reference Mic.

Depending on selected input
range,

6 ranges available

-35dB (0 dB=1V/pa, 1000
Hz)

Measurement Range

40 dB SPL to 100 dB SPL

B.2.3 HIT system

No. of channels:

2 channel - One coupler
microphone and one
reference microphone

Signal types:

Pure tone, modulated tone,
narrowband noise, white
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noise, speech-weighted
noise, and pink noise.

For technical specifications
refer to section B.2.1.

Frequency range:

200 Hz - 16 kHz

Signal levels:

40 - 100 dB SPL

Tolerance, dB:

+/- 1,5 dB in the frequency
range 200 - 2000 Hz and +/-
2,5 dB in the frequency range
2000 - 5000 Hz and above.

Pure tone accuracy:

+/-2%

Distortion:

Less than 0,5% at 70 dB.
Less than 2% at 90 dB.

B.2.4 Insert Phone/Insert Earphone Flex

Insert Phone/Insert
Earphone Flex

Including Audiometric insert
earphones

Frequency range:

125 Hz to 8 kHz

Maximum output level:

Up to 120 dB HL at mid
frequencies

Compliance:

EN 60645 and ISO 389-2

B.2.5 Real Ear Probe/REM Probe Flex

Real Ear Probe/REM Probe
Flex

Adjustable left and right-ear
hangers, each with reference
and probe tube microphone

Frequency range:

125 Hz to 16 kHz

Maximum input level for
probe tube input:

125 dB SPL with less than
3% distortion.
Up to 135 dB SPL

B.3 EMC Conformance Requirements

B.3.1 EMC Classification, Standards and Test Methods

Emissions:

EN 55011/CISPR11, Group 1, Class B

Harmonic Current Emission:

IEC 61000-3-2:2018, Class A

Voltage Fluctuations and Flicker: IEC 61000-3-3:2013
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Immunity:

Test levels for professional healthcare environment.

Enclosure Port:

Basic EMC standard

Immunity test level

IEC 61000-4-2 (ESD)

+ 8 kV contact, + 2 kV, £ 4 kV, £ 8 kV, £ 15 KV air

IEC 61000-4-3 (rad. Fields)

3V/m, 80 MHz - 2,7 GHz, 80 % AM at 1 kHz

& Test points / frequencies according to table 9 of
IEC/EN 60601-1-2 (RF wireless communications
equipment):

385 MHz; Pulse Modulation: 18 Hz; 27 V/m
450 MHz, FM + 5Hz deviation: 1 kHz sine; 28 V/m

710, 745, 780 MHz; Pulse Modulation: 217 Hz; 9
V/m

810, 870, 930 MHz; Pulse Modulation: 18 Hz; 28
V/m

1720, 1845, 1970 MHz; Pulse Mod.: 217 Hz; 28 V/m
2450 MHz; Pulse Modulation: 217 Hz; 28 V/m;
5240, 5500, 5785 MHz; Pulse Mod.: 217 Hz; 9 V/m

IEC 61000-4-8 (magn. Fields)

30A/m, 50 Hz & 60 Hz

Input a.c. Power Port:

Basic EMC standard

Immunity test level

IEC 61000-4-4 (bursts)

+ 2 kV, 100 kHz repetition frequency

IEC 61000-4-5 (surges)

+ 0,5kV, £ 1 kV, line to line

IEC 61000-4-6 (cond. RF)

3V/m, 0,15 MHz - 80 MHz, 80 % AM at 1 kHz
6 V/m in ISM bands between 0,15 MHz and 80 MHz

IEC 61000-4-11 (volt. dips)

0% UT; 0,5 cycleat0°,45°,90°, 135°, 180°,
225°,270°

and 315°.0 % UT; 1 cycle and 70 % UT; 25/30 cycles
ato°

IEC 61000-4-11 (volt. inter.)

0 % UT; 250/300 cycle

Patient Coupling Port: Device has no patient coupling port

Signal Input / Output Port:

Basic EMC standard

Immunity test level

IEC 61000-4-2 (ESD)

+ 8 kV contact, + 2 kV, + 4 kV, + 8 kV, + 15 kV air

IEC 61000-4-4 (bursts)

Only applicable for patient headsets, patient client
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might be > 3m.

switch and speaker cables because cable length

IEC 61000-4-5 (surges)

door cables.

N/A; all SIP/SOP cables not directly connected to out-

IEC 61000-4-6 (cond. RF)

might be > 3m.

Only applicable for patient headsets, patient client
switch and speaker cables because cable length

B.3.2 Maximum permissible Cable Lengths of Accessories

Accessory, Transducer

Maximum cable length

Client response switch

Air conductor headsets like
TDH39, DD45, DD450,
HDA300

Bone conductor headsets
like B71

Power Supply (low voltage 1,8 meters

side)

USB cable 3 meters

REM probes 2,5 meters (In combination

with extension cable
91.0704 prolongable up to
5,5 meters)

Insert headsets like EAR-3A,
ER-3C

2 meters (In combination with
extension cable 91.0704
prolongable up to 5,5 meters)

Free field calibration 3 meters
microphone

Table microphone (Talk back | 2,5 meters
microphone)

Headset with microphone 2,5 meters
(Monitor headset)

Loudspeaker LSO1 5 meters
RECD Speaker LS Mini 2,5 meters
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B.4 Pin Assignments Table

Primus Fitting Unit

Connector

Air Conductor 1, 2, 3 |BOne Conductor

Standard DIN Connector 8 pins

female

1. Ground 1. Output

2. Data Up/Down- 2. Data

load Up/Download

3. Ground 3. Not Con-
nected

4. Optional Micro- 4. Not Con-

phone Input nected

5. Plug Detect 5. Plug Detect

6. Left Channel Out-

6. Ground
put
7. Right Channel Out- | 7. Not Con-
put nected
8. Ground 8. Ground

Option™2*3

Primus Probe*1/Real Ear
Probe *2*3

Client Response

1. Secondary Micro-
phone Input

1. Ground

1. Not Connected

2. Data Up/Download

2. Data Up/Download

2. Logic Input (High/Low)

3. Ground

3. Ground

3. Not Connected

4. Primary Microphone
Input

4. Reference Microphone
Input, Left

4. +3.3Vdc

5. Plug Detect

5. Reference Microphone
Input, Right

5. Plug Detect

6. Speaker Output,
positive

6. Probe Microphone Input,
Left

6. Control Clock

7. Speaker Output,
negative

7. Probe Microphone Input,
Right

7. Control Data

8. Ground

8. Ground

8. Ground
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Connector

Client*1"2/Demo ™3
Headset

Free Field: Left/Right, Rear
and Sub/Mid*1*2

Free Field: Line out 1, Line out
2 Line out 3*3

3.5 mm TRS socket (mini-jack)

1. Left Channel
Output

1. Channel 1,3,5 Output

2. Right Channel
Output

2. Channel 2,4,6 Output

3. Ground 3. Ground

. Operator Micro- Operator Micro- .
Monitor Headset phone Left phone Right Talk Back Microphone
1. Left Channel
Output 1. Input 1. Input 1. Input
2. Right Channel 2. Not Connected | 2. Not Connected | 2. Not Connected
Output
3. Ground 3. Ground 3. Ground 3. Ground

Power supply: DC POWER JACK

1.+15 Vdc, 2A max
(Center)

2. Ground (Sleeve)
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USB: Type B connector
1. 5 Vdc, 0.5A max
2. Data -
1 2
— —
- _— 3. Data +
4 3
4. Ground
| — SPDIF: Toslink optical

transmitter™3
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Speaker Output Right, Mid, Left
1. Positive
2. Negative
1 2
*1 This plug is only available in the PFU.
*2 This plug is only available in the PFU+.
*3 This plug is only available in the Primus Pro.
2000-1 Fitting Unit
8-pin Mini-Din Connector
. Connector
Front View .
Pin AC1 Client REM
, ien .
AC2 BC Resp. | OPU" | probe
. |Pue Plug Plug Plug fele%‘n?vllic
detect detect detect detect R ) '
Signal Signal
2 Ground | Ground |+3.3VDC | Coupler Ref. Mic.
Mic. L
RECD Signal
3 Signal R | Signal I2C Data | Speaker | Tube
+ Mic. R
4 Data Data Pat. Signal Data Data
RECD Signal
5 Signal L | Signal I2S Clock | Speaker - | Tube
Mic. L
6 Ground | Sig. Ground Ground Ground
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. Tube
R Ground Ref. Mic. Mic. R
Ground Ground
7 Ground | Ground | Ground Coupl. Ref. Mic.
Mic. L&R
. ) Ground
3 Ground | Sig. Ground Slgnall Tube
L Ground Ref. Mic. .
Mic. L
3.5 mm Stereo Jack Connector
Talk Back
o Monitor Microphone,
in Operator
Headset, .
Line Out Microphone,
Ambient
Microphone
. Signal Input
, Signal Out-| -
1 (Tip) out Left (Bias Voltage)
. Signal Out-| Not con-
2 (Ring) put Right [ nected
3
(Sleeve) Ground Ground
Power Supply, DC Power Jack Pin Signal
m | Center Pin +15VDC / max. 2A
Sleeve Ground
Speaker, Left and Right Pin Signal
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Positive Terminal

Negative Terminal
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Appendix C

C.1 Minimum Requirements (for Software Installation)

C.1.1 PC specifications for the connected operator PC

Minimum requirements

Recommended requirements

Processor/clock speed

2 GHz

2 GHz (or higher) multi-core

System RAM

2GB

4 GB or more

Free hard drive space

2GB

2GB

Operating System*

Windows 10 and Windows 10
Anniversary Update

Windows 10 and Windows 10
Anniversary Update

Windows 11
Screen Resolution 1280 x 1024 1600 x 1200
Graphics Card XVGA Dual monitor output

CD Drive

Required if speech test CD "s
are used.

Required if speech test CD "s
are used.

Connection of Fitting
System to PC

USB connector 2.0 or higher

USB connector 2.0 or higher

Connection of HIT System
to PC (optional)

USB connector 2.0** or higher

USB connector 2.0** or higher

* Your OS must be up to date. All Windows updates must be installed.

** |f a USB hub must be used in order to connect both units, a hub with power supply is

recommended.
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